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Contact and Support Information
Return to Table of Contents.

Product information can be accessed by visiting Customer Support online: CCH Axcess Product Support.

In addition to product and account information, the Customer Support site offers answers to our most
frequently asked questions, forms release status, Knowledge Base articles, training videos, and operating
systems compatibility for each CCH Axcess™ module. Access to these features is available 24/7.

The following Web site provides important information about the features and updates included in all CCH
Axcess Tax releases: Release Notes.

Visit the Application Status Web page to view the current status of our CCH Axcess applications. The
Application Status Web page is updated every 15 minutes.

Go to Contact Us to open a Support case or chat with a representative for assistance.
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https://support.cch.com/productsupport/productsupport.aspx?id=37
https://support.cch.com/Axcess/ReleaseNotes/Tax
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Information in Tax Release Notes
Return to Table of Contents.

CCH Axcess™ Tax Release Notes inform you of the enhancements and updates that were made to Tax
products and systems with the current release.

Information provided in the Release Notes include the following:

Contact and Support information
Updates to Tax technology (such as, electronic filing updates, Organizer, Pro Forma/roll
forward, and technology enhancements)
Updates made to Tax products (such as, form additions and updates, changes in diagnostics,
and changes caused by regulatory updates)

To access a list of CCH Axcess™ Tax Release Notes for the current year and for prior years, visit the Release
Notes page on our Customer Support site.
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Highlights for Release 2018-1.0
Return to Table of Contents.

CCH Axcess Common

CCH Axcess Login
The following changes apply to the CCH Axcess Login window:

To comply with government regulations and for your online security, the Remember me option
is being removed. Upon the first log in after the deployment of release 2018-1.0, we will
populate the User ID and display a notification that this feature is being removed. If you
previously used this feature, please retain your User ID for future use. The User ID will no
longer pre-populate on any subsequent log ins.
We added the Forgot User ID option. After entering the email address that is in your staff
profile as your system email address, you will receive an email containing your user ID.
A new IRS Security Best Practices section was added with links to IRS publications.

CCH Axcess Password Changes
Changes are being made to how many times a password may be changed within a 24 hour period. We will
allow a password to be changed only once within 24 hours. This is only applicable when you opt to change
your password. It is not applicable to the Forgot Password option, nor is it applicable to CCH Axcess login
information emails initiated by the Administrator, as they both use temporary passwords that users must
change when logging in.

Microsoft® Office 2019 Support

Our products are now compatible with Microsoft® Office 2019.

CCH Axcess Tax

All Return Types
You can now prepare 2018 returns.

Roll Forward
You may now roll forward your 2017 returns and templates to 2018 in both Return Manager and Batch
Manager.

Email Address Validation
For 2018 Individual (1040) returns and higher, we now validate that a properly formatted email address is
entered for the taxpayer, spouse, and preparer.
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Return Balance Due or Refund Display
After each calculation, the return's balance due or refund amounts are refreshed for the federal and home
state units on the right side of the tax return window above the ribbon. This provides the monetary
obligation or benefit for the return without having to navigate to worksheets or government forms.

After entering new input, the amounts display in gray text, alerting you to calculate the return to display
the current amounts in green (refund due) or black (balance due) text.

Notes:

This option applies to Individual, Fiduciary, Corporation, and Estate & Gift returns for tax years
2016 and higher.
For home states:

A valid home state must be entered to display state amounts; otherwise, no state
information is displayed.
Home state amounts include residents, part-year residents, and nonresidents.

Home state information does not display if the option Suppress automatic state return is
selected in Return Options > Processing Options.

Electronic Filing PDF Attachments
Tax authorities do not accept PDF files that are password protected. For this reason, you can no longer
attach or upload password protected PDF files for electronic filing.

Government Form Entity Selection
After selecting to open a government form entity, the Select Entity window now remains open with the open
entity highlighted. When working with a large number of entities, this allows you to easily and quickly
navigate to the next entity. You can also reposition and resize the Select Entity window to display more
entities without scrolling.

Extender Legislation
We are monitoring Extender Legislation pending in Congress, and will provide updates as legislation
proceeds.

Tax Reform Changes
The passage of the Tax Cuts and Jobs Act (TCJA) delivered the most expansive change in tax preparation in
over 30 years, impacting all systems and states, including electronic filing.

For changes included in release 2018-1.0, refer to Product Enhancements for each return type.

We will continue to communicate the highlights of additional significant changes as they are made available
on future releases.
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The following forms will be available on a future release:

Form System Note

Form 461, Limitation
on Business Losses

1040,
1041, 990

N/A

Form 8990, Limitation
on Business Interest
Expense IRC 163(j)

All
applicable
systems

N/A

Form 8992, U.S
Shareholder Calculation
of Global Intangible
Low-Taxed Income
(GILTI)

All
applicable
systems

N/A

Form 8994, Employer
Credit for Paid Family
and Medical Leave

All
applicable
systems

N/A

Form 1065, Schedule B-
2, Election Out of the
Centralized Partnership
Audit Regime

1065 N/A

Form 8979, Partnership
Representative
Revocation,
Designation, and
Resignation

1065 N/A

Section 199A
All
applicable
systems

A new set of worksheets will be available for the
Qualified Business Income Deduction.
New worksheets to compute this QBI deduction for
applicable schedules, new fields to include/exclude
business entities from QB status, new fields per asset
to include/exclude assets from UBIA, new fields for
ADS assets to alter the life.

Form 5471, Multiple
new schedules will be
available on future
releases

All
applicable
systems

N/A

Form 8865, Multiple
new schedules will be
available on future
releases

All
applicable
systems

N/A

Form 965
All
applicable
systems

E-fileable.
Payments will be allowed separately from return
payments.
Multiple new schedules will be available on future
releases.
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Issues Resolved

DataScan searches no longer stall when duplicate records are encountered. It will run through a
new process to clean up duplicates in the temporary database, and then continue with the
processing.
An invalid Taxing Authority no longer appears in the return.
You will no longer see custom paragraphs that were not created.
You can now roll forward 1120S returns when certain fields are present in the prior year return
on the Fiduciary Passthrough worksheet.
You can now correctly view and print certain consolidated columnar Schedule M-3 statements.
You will no longer receive a sporadic error message when using File > Save As.
Dates of Reports by Grantee now export and import correctly for trust returns.

Reminder: Default Option Updates Previously Released With 2017-5.0
Firm Settings and Defaults

We added the following new option under Firm Settings and defaults > Tax > Options:

Do not allow suppression of nonfileable message on signature forms
Cleared by default.

When enabled, we will disable the option Do not print nonfileable message on signature
forms on the Electronic Filing Options > General tab for all return configuration sets.
For 2018 and higher returns, it will also disable the return level override.

Return Configuration Settings (RCS)

Options Removed:
Depreciation reports page orientation from Print Options.

Suppress input listing from Print Options.

Options Modified:
Moved the current option ERO signature options for Form 8879 on the Electronic Filing >
General tab to each return type tab (except 5500) under Electronic Filing.
Renamed the option Short form option to Short form option (2017 and prior), as it no
longer applies to newer returns.

New Organizer Option:
Added Suppress driver's license number to the Organizer tab that applies to 2018 and
higher organizers.

CCH Axcess™ DataScan
You can now create queries and scan 2018 returns. System defined keywords and scans for 2018 will be
available on an upcoming release.
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CCH Axcess™ Tax Notebook Toolkit
Tax Notebook Toolkit is now available for processing and for creating Tax Notebooks.

To ensure that your clients have the most secure interface with their online organizer and sensitive tax
data, 2-Step Verification will be enabled by default. Firms may choose to disable this feature in the Firm
Options in the Toolkit. We strongly discourage the disabling of 2-Step Verification.

CCH® My1040Data
My1040Data Toolkit is now available for 2018 processing and for creating My1040Data organizers.

To ensure that your clients have the most secure interface with their online organizer and sensitive tax
data, 2-Step Verification will be enabled by default. Firms may choose to disable this feature in the Firm
Options in the Toolkit. We strongly discourage the disabling of 2-Step Verification.

As early as January 2019, users of the My1040Data electronic organizer will have the opportunity to link
with more than 300 of the largest brokerage houses, financial institutions, and payroll companies. Via
integration with third-parties, clients can electronically retrieve and attach annual tax documents directly
within My1040Data.

Highlights for Release 2018-1.0 • 8



Tax Product Enhancements
Click any of the links below to read about the tax application enhancements included with release 2018-1.0.

Individual (1040) Product Enhancements

Partnership (1065) Product Enhancements

Corporation (1120) Product Enhancements

S Corporation (1120S) Product Enhancements

Fiduciary (1041) Product Enhancements

Estate and Gift (706/709) Product Enhancements

Exempt (990) Product Enhancements

Employee Benefit Plan (5500) Product Enhancements
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Individual (1040) Product Enhancements
Return to Table of Contents.

Federal

Tax Reform Changes to Existing Forms

Form 1040

Updated standard deduction.
Removed personal exemptions.

Schedule A

Limited state and local taxes (Line 5).
Removed miscellaneous deductions.
Changed charitable contributions rate for cash to 60%.
Removed Itemized deductions worksheet for phaseout.

Corresponding changes were made to Form 1040NR, Form 1116, and Tax Equalization.

Schedule C

Business meals and entertainment are more strictly limited.
Removed Entertainment from Travel, Meals and Entertainment text on Schedule, C, Line 24.

Schedule D

Updated capital gains thresholds on the Schedule D worksheet, Line 15 and Line 24.
Where appropriate, corresponding changes were made to Form 1116, Tax Equalization, and the
Tentative Credit for Prior Year Minimum Tax.

Schedule 8812

Removed Part I, Filers Who Have Certain Child Dependent(s) with an Individual Taxpayer
Identification Number (ITIN).
Schedule 8812 is no longer produced for dependents for whom the credit is claimed and that
also have an ITIN.
Schedule 8812 is no longer produced for dependents for whom the credit is claimed with an
“applied for” ITIN or that have a W-7 in the return.
Limited the additional child tax credit to $1,400 per eligible child.
Where appropriate, Tax Equalization follows suit.

Form 1116

Added new income baskets, Section 951A & Foreign branch.
Recharacterizated overall domestic losses. The taxpayer may elect to recharacterize an
amount greater than 50%, up to 100%.
On the Itemized deduction worksheet:

Removed deductions subject to 2% limit.

Removed phaseout calculation.
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Where appropriate, Tax Equalization follows suit.

Form 2106

Form 2106 no longer allows entertainment expenses subject to the 50% limit to be deducted. For this reason,
50% entertainment expenses were moved to a new box and made “State Use.”

Form 2555

Updated maximum foreign income exclusion.
Updated housing limits.
Where appropriate, Tax Equalization follows suit.

Form 3903

Only military moving expenses are deductible.

Form 8615

Estate and trust tax rates are used.
The import feature is only used by states, as federal no longer references family income.

NOL

Current year
Removed adjustment for DPAD deduction.

Carryover worksheet
Removed adjustment for miscellaneous itemized deductions subject to 2% of AGI limit.

Removed adjustment for itemized deduction phaseout.

Removed adjustment for DPAD deduction.

Section 933

Removed adjustment for personal exemptions.
Removed adjustment for miscellaneous deduction subject to 2% of AGI.
Adjustment for DPAD deduction will be removed.

Form 965

Form is e-fileable.
Payments will be integrated with return payments.

Note: All federal changes are being made with deconforming states in mind, designating existing
federal input as “State Only” for continued use.

Section 199A

A new set of worksheets will be available for the Qualified Business Income Deduction.

No worksheets have been released by the IRS, so we are proceeding with implementing a version designed
internally. This includes new worksheets to compute this QBI deduction for applicable schedules, new fields
to include/exclude business entities from QB status, new fields per asset to include/exclude assets from
UBIA, and new fields for ADS assets to alter the life.
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Income > Sch C – Business > Qualified Business Income
Income > Sch E, p 1 – Rent and Royalty > Qualified Business Income
Income > Sch E, p 2 – Fiduciary Passthrough (K-1 1041) > Qualified Business Income
Income > Sch E, p 2 – Partnership Passthrough (K-1 1065) > Qualified Business Income
Income > Sch E, p 2 – Large Partnership Passthrough (K-1 1065-B) > Qualified Business Income
Income > Sch E, p 2 – S Corporation Passthrough (K-1 1120S) > Qualified Business Income
Deductions > Qualified Business Income
Income > Sch F / 4835 – Farm > Qualified Business Income

New Forms

The postcard form replaces Form 1040, 1040A, 1040EZ:
Form 1040 Sch. 1 Additional Income and Adjustments to Income

Form 1040 Sch. 2 Tax

Form 1040 Sch. 3 Non-refundable Credits

Form 1040 Sch. 4 Other Taxes

Form 1040 Sch. 5 Other Payments and Refundable Credits

Form 1040 Sch. 6 Foreign Address and Third Party Designee

Tax Projector and Tax Equalization follow the new postcard format

Form 8838-P, Consent to Extend Time to Assess Tax Per Gain Deferral Method
Form 8990, Limitation on Business Interest Expense IRC 163(j)
Form 8992, U.S Shareholder Calculation of Global Intangible Low-Taxed Income (GILTI)

Taxes > 8992 – U.S. Shareholder Calculation of Global Intangible Low-Taxed Income
(GILTI)

Form 8994, Employer Credit for Paid Family and Medical Leave
Income > Sch C – Business > Form 8994 – Employer Credit for Paid Family and Medical
Leave
Income > Sch E, p 2 – Fiduciary Passthrough (K-1 1041) > Form 8994 – Employer Credit for
Paid Family and Medical Leave
Income > Sch E, p 2 – Partnership Passthrough (K-1 1065) > Form 8994 – Employer Credit
for Paid Family and Medical Leave
Income > Sch E, p 2 – Large Partnership Passthrough (K-1 1065-B) > Form 8994 – Employer
Credit for Paid Family and Medical Leave
Income > Sch E, p 2 – S Corporation Passthrough (K-1 1120S) > Form 8994 – Employer
Credit for Paid Family and Medical Leave
Income > Sch F / 4835 – Farm > Form 8994 – Employer Credit for Paid Family and Medical
Leave

Form 461, Limitation on Business Losses
Income > 461 – Limitation on Business Losses

New Schedules for Existing Forms

Form 5471 Sch. E Income, War Profits, and Excess Profits Taxes Paid or Accrued
Form 5471 Sch. H Current Earnings and Profits
Form 5471 Sch. I-1 Information for Global Intangible Low-Taxed Income.

Tax Product Enhancements • 12



Form 5471 Sch. P Transfer of Property to a Foreign Corporation
Form 8865 Sch. G Statement of Application for the Gain Deferral Method Under Section 721(c)
Form 8865 Sch. H Transactions Between controlled Foreign Partnership and Partners or Other
Related persons
Form 965 Sch. A U.S. Shareholder's Section 965(a) Inclusion Amount
Form 965 Sch. B Deferred Foreign Income Corporation's Earnings and Profits
Form 965 Sch. C U.S. Shareholder's Aggregate Foreign Earnings and Profits Deficit
Form 965 Sch. D U.S. Shareholder's Aggregate Foreign Cash Position
Form 965 Sch. E U.S. Shareholder's Aggregate Foreign Cash Position Detail
Form 965 Sch. F Foreign Taxes Deemed Paid by Domestic Corporation for U.S. Shareholder Tax
Form 965 Sch. G Foreign Taxes Deemed Paid by Domestic Corporation (for U.S. Shareholder Tax
Year Ending in 2017)
Form 965 Sch. H Disallowance of Foreign Tax Credit and Amounts Reported on Forms 1116 and
1118
Form 965-A, Individual Report of Net 965 Tax Liability
Form 965 Inclusion of Deferred Foreign Income Upon Transition to Participate Exemption
System

Obsolete Forms

Form 1040A – U.S. Individual Income Tax Return
Form 1040EZ – Income Tax Return for Single and Joint Filers with No Dependents
Form 2106-EZ – Unreimbursed Employee Business Expenses

Enhancements

Interest and Dividend Summary

Added new columns for:

Market discount
Section 199A dividends
Unrecaptured Section 1250 gain
Section 1202 gain
Collectibles
Investment expense

Organizer

Added a question for “Did you sell or exchange Bitcoin or other cryptocurrencies or engage in any sales or
exchanges denominated in Bitcoin or other cryptocurrencies?”

Tax Projector

Added the bracket tax rate to the Summary page so you can see the rate for each year.

Form 2555

Added an option to reduce Form 1040 other income by camp housing added.

2555, Foreign Earned Income Exclusion > Value of Meals and Lodging Included In Income >
Include amount excludable as a reduction to Form 1040, Schedule 1, Line 21
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Form 8886

Overflows to the form, rather than to a statement. This does not apply to Line 1c, which indicates a
statement is needed.

Form 8958

To allow for more flexibility in return preparation, input for Form 8958 was redesigned.

8958 – Allocation of Tax Amounts Between Certain Individuals in Community Property States

NOL

The carryover detail worksheet prints when the full NOL carryover to 2018 is absorbed in the current year.

Gains and Losses

Duplicate input has been removed from the Gains and Losses worksheet.

IRS 1099-MISC

Moved the “no 1099 received” field near the top of the form.

Batch e-File of Extensions With Amounts

Through OIP, you can batch e-file 1040 extensions including "amounts withheld and paid in" in
the electronic file.
Currently, e-filed extensions have zero on all lines.
You must populate the pertinent extension Worksheet override fields using Tax Transfer.
Tax Transfer will create returns if they don’t exist.
Supported states: AR, AZ, CT, DC, DE (new for 2018), LA, NC, NJ, NY, NYC, PA, VT

States

Tax Changes to Existing Forms

Connecticut

Added input for 965 taxable income to Income/Deductions > Nonresident and Part-year
Information. This amount will flow to 1040 NR\PY and to state Form 8960, Line 7. This change
is for tax year 2017 only.
Bonus depreciation will be added back on all assets placed in service after 9/27/17. This is
calculated automatically. The overrides are on Income/Deductions worksheet > Additions
section > Section 168(k) bonus depreciation fields.

Indiana

Resident is an automatic calc (the input overrides are below). Non-Resident uses input only.

Indiana > Income / Deductions > 2 – Tax Add-Back > Line 5 – Section 965 deduction – IT-40PNR
(overrides IT-40)
Also reported on Indiana Schedule K-1:

Indiana > Other > 4 – Indiana Sch IN K-1 > Line 12 Grid – Code 139 for 965
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Kentucky

Kentucky did not conform to 965 for tax year 2017. Repatriation income included in federal
AGI is subtracted from Kentucky AGI on 2017 Kentucky Schedule M, Line 19.
Does not adopt the increased expensing and depreciation provisions for capital improvements.
The current graduated tax system, with rates ranging from 2% to 6%, is converted to a flat rate
of 5% for all taxpayers effective for tax years beginning on or after January 1, 2018.
The personal credit of $10 per person is repealed.
The only itemized deductions allowed are deductions for mortgage interest and charitable
contributions. All other itemized deductions (medical insurance, medical expenses, local
occupational taxes and property taxes paid, interest expense on investments, casualty and
theft losses, and other miscellaneous deductions) are eliminated.
Long-term care and health insurance premiums allowed previously as a deduction from
Kentucky adjusted gross income are no longer allowed.
Historically, Kentucky has permitted $41,110 per person of pension income to be excluded
from taxable income. For 2018, that exclusion is reduced to $31,110 per person. Social
Security continues to be fully exempted from Kentucky income tax.

Ohio Cities

New NOL carryover law is being applied to OHC. All cities will allow 50% of the NOL generated from 2017.
Cities that implemented income tax after 1/1/2016 will allow 100% of the NOL generated in 2017.

Oregon

Individuals in Oregon must add back the federal deduction for repatriation income under
Internal Revenue Code (IRC) §965. Taxpayers should use addition code 162 (“Capital loss with
Oregon-only tax benefit” even though the description does not match) to add the deduction
amount to their 2017 Oregon personal income tax return.

For input, CCH customers should use addition code 119 rather than code 162 on Oregon >
Income / Deductions > Additions to file the repatriation add-back for tax year 2017.

Decouples from federal 20 percent pass-through income tax deduction included under IRC Sec.
199A (QBID).
2018 Oregon Individual Income Tax Rates:

Not over $3,450
5% of taxable
income

Over $3,450 but not
over $8,700

$173 plus 7% of
excess over $3,450

Over $8,700 but not
over $125,000

$540 plus 9% of
excess over $8,700

Over $125,000
$11,007 plus 9.9% of
excess over
$125,000

Oregon will retain personal exemptions.
Sole proprietorships may now claim the reduced rate (Schedule OR-PTE) for tax years beginning
on or after January 1, 2018.
The IRC §965 repatriation income deduction is added back with addition code 184.
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New Forms

Alabama

Schedule DS & HOF – Dependents and Head of Family Schedule
Basic Data > General

Basic Data > Dependents

Refundable Credit Schedule
AL Credits > Sections 8 – 13

Arkansas

Form AR 4684 – Casualties and Thefts
Form AR2106 – Employee Business Expense

Deductions > Employee Business Expenses > Business Income and Expenses

Deductions > Employee Business Expenses > Business Use of Home

Deductions > Employee Business Expenses > Reimbursements

Form AR3903 – Moving Expenses
Deductions > Moving Expenses > Schedule of Expenses

District of Columbia

D-30 NOL
UBT General > Net Operating Loss Deduction

Form DC-8379 – Injured Spouse Allocation
Other > 8379 – Injured Spouse Claim

Schedule ELC
2441 – Child and Dependent Care Expenses

Georgia

500-NOL

Income > Net Operating Loss

Illinois

Schedule IL-EIC
IL Credits > Schedule IL-EIC

Schedule IL-WIT – Illinois Income Tax Withheld
Calculated

Indiana

Form IN-48725 – Business Entity Report
Indiana > Other worksheet > Business Entity Report – General Information and Business
Entity Report – Governing Person Information sections

Form IN IT-40 Schedule 4 – Other Taxes, Line 1
Indiana > Taxes worksheet > Taxes section > Sales / Use tax on out-of-state purchases
field
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Form IN IT-40 Schedule 4 – Other Taxes, Line 2
Indiana > Taxes worksheet > Taxes section > Household employment taxes field

Form IN IT-40 Schedule 4 – Other Taxes, Line 3
Flows from Form IN-529R

Form IN IT-40PNR Schedule E – Other Taxes, Line 1
Indiana > Taxes worksheet > Taxes section > Sales / Use tax on out-of-state purchases
field

Form IN IT-40PNR Schedule E – Other Taxes, Line 2
Indiana > Taxes worksheet > Taxes section > Household employment taxes field

Form IN IT-40PNR Schedule E – Other Taxes, Line 3
Flows from Form IN-529R

Form IN IT-40PNR Schedule E – Other Taxes, Line 4
Flows from Form IN-PRO, Line 11 (part of Form IN IT-40PNR Schedule E)

Form IN IT-40PNR Schedule IN-PRO – Nonresident Professional Team Member County Tax
Input Scheme Pending Government Instructions

Iowa

IA 140 – Iowa Geothermal Tax Credit
IA Credits > Geothermal Tax Credit

IA 2106 – Employee Business Expenses Worksheet
2106 / Stmt SBE – Employee Business Expenses

IA 3903 – Moving Expense Worksheet
3903 – Moving Expenses

IA 4684 – Casualty and Theft Worksheet
Gains and Losses > Business Property, Casualties and Thefts

Kentucky

Schedule INV, Kentucky Inventory Tax Credit (Ad Valorem) for individual (740 and 740-NP) and
LLC (725) income tax returns

Kentucky > Credits > Inventory Tax Credit (Schedule INV)

Schedule ITC, Kentucky Individual Tax Credit Schedule for residents (740), part-year and
nonresidents (740-NP)

Kentucky > Credits > Other Credits

Form KY 740-X, Amended Kentucky Individual Income Tax Worksheet
Kentucky > Amended worksheet > Amended section

Louisiana

Form R-6410 – Legislation Credit Recovery Worksheet
R-2867 – Transmittal of Federal Extension Request as LA Extension

Michigan

Form MI-461 Excess Business Loss
Income > 461 – Limitation on Business Losses
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Form 5606, Excess Business Loss Continuation

Minnesota

Schedule M1CAT, Casualty and Theft
Gains and Losses > Business Property, Casualties and Thefts

Schedule LK, Like Kind Exchange
8824 – Like-Kind Exchanges

Schedule M1NC, Federal Adjustments
MN Income/Adjustments > Schedule M1NC

Schedule KFNC, Federal Adjustments
Work in progress

Schedule KPINC, Federal Adjustments
Work in progress

Schedule KSNC, Federal Adjustments
Work in progress

Schedule M1MOVE, Moving Expenses
3903 – Moving Expenses

Schedule M1SA, Itemized Deductions
Sch A – Itemized Deductions

Schedule M1UE, Unreimbursed Business Expenses
2106 / Stmt SBE – Employee Business Expenses

Nebraska

Form TANF, Employer’s Credit for Expenses Incurred for TANF(ADC) Recipients

New Hampshire

Schedule IV, Other IRC Reconciling Adjustments

NH > Business Profits Tax > NH Sch IV IRC Adjustments

New York

Form IT-196, Res/NR/PY Itemized Deductions
Replaces IT-201-D and IT-203-D

Form IT-647, Farm Workforce Retention Credit
New York > Credits > Farm Workforce Retention Credit

Form IT-647-ATT, Eligible Farm Employee Information
New York > Credits > Farm Workforce Retention Credit

Form IT-649, Farm Workforce Retention Credit
New York > Credits > Farm Donations to Food Pantries

Deduction Limits Worksheet

North Carolina

Form D-400 Schedule PN (added late in the tax year 2017 software)
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Input overrides are on North Carolina > Income/Deductions > 4. Nonresident and Part-year
Information.

Ohio

New version of TBOR1, Declaration of Tax Representative

Oklahoma

Schedule HI (formerly Schedule GH)

Oklahoma > General worksheet > Contributions section

Oregon

Schedule OR-A, Oregon Itemized Deductions

The input scheme is to be determined, but the data will largely be from Federal Schedule A.

Rhode Island

Schedule E, Exemption Schedule

Basic Data > General
Basic Data > Dependents

Tennessee

Estimate payments now pro forma in prior year boxes.
Added new option “TNL” for Tennessee – FAE 172 input in the federal Payments > State
Estimated Tax Payments Summary > State field.

Additions from late in the tax year 2017 software:
Form INC 251 ES, Prepayment of Individual Income Tax (paper filing)

Form FAE 172, Estimated Tax Declaration (electronic filing)

Form AFE, Application for Exemption, and Form FAE 183, Annual Exemption Renewal,
were combined into Form FAE 183, Application for Exemption/Annual Exemption Renewal
Form IE, Intangible Expense Disclosure

Virginia

Credit for Taxes Paid worksheet for e-file
Work in progress

VA Schedule A – Itemized Deductions
Sch A – Itemized Deductions

Schedule ADJS – VA Supplemental Schedule of Adjustments

Wisconsin

Schedule NOL
Net Operating Loss

Schedule ES – Employee College Savings Account Credit
WI Credits > Employee College Savings Account Contribution Credit

Schedule EIT - Electronics and Information Technology Credit
WI Credits > Electronics and IT Manufacturing Zone Credit
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Schedule LI – Low-Income Housing Tax Credit
WI Credits > Low-Income Housing Credit

Enhancements

Colorado

Added electronic filing for extensions.

Connecticut

Added electronic filing for estimate payments.

Illinois

Automated calculations on Schedule K-1-P and Schedule K-1-T to flow from federal.

Overrides are on IL Sch K-1-P and Sch K-1-T.

Maryland

Added electronic filing for estimate payments.

Michigan Cities

Added Benton Harbor.
Added EF for Walker, Jackson, Muskegon Heights.

New Jersey

Added electronic filing for estimate payments.

Ohio

Removed the Annualization section of OH IT 2210 and OH SD 2210, Underpayments of Estimated Tax.

Pennsylvania Cities

Added ability to enter separate taxpayer/spouse estimate information on Pennsylvania Cities >
Estimates/Underpayments.
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Partnership (1065) Product Enhancements
Return to Table of Contents.

Federal

Tax Reform Changes to Existing Forms

Form 1065

Form 1065 Technical termination box removed.
Form 1065, Page 1, Lines 23 through 30 are new.
Form 1065, Page 2, Lines 2 and 5 removed.
Form 1065, Page 3, Lines 21 through 26 are new.
Form 1065, “Designation of Tax Matters Partner” is now “Designation of Partnership
Representative.”

Schedule K-1

New Line 6c for Dividend equivalents.
Addition of Line 20 codes Z and AA through AH for Sec 199A reporting.
Removal of DPAD information from Schedule K-1 (Line 13 codes T-V) Reserved for Future Use.

Form 965

Form is e-fileable.
Payments will be integrated with return payments.

Form 8082, Notice of Inconsistent Treatment or Administrative Adjustment Request (AAR)

Additional questions in Part 1.
Line 2 options have changed.

Note: All federal changes are being made with deconforming states in mind, designating existing
federal input as “State Only” for continued use.

Section 199A

A new set of worksheets will be available for the Qualified Business Income Deduction.

No worksheets have been released by the IRS, so we are proceeding with implementing a version designed
internally. This includes new worksheets to compute this QBI deduction for applicable schedules, new fields
to include/exclude business entities from QB status, new fields per asset to include/exclude assets from
UBIA, and new fields for ADS assets to alter the life.

Federal > Income/Deductions > Section 199A – Qualified Business Income

New Forms

Form 1065, Schedule B-2, Election Out of the Centralized Partnership Audit Regime
Form 8838-P, Consent to Extend Time to Assess Tax Per Gain Deferral Method
Form 8979, Partnership Representative Revocation, Designation, and Resignation Form
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Form 8990, Limitation on Business Interest Expense IRC 163(j)
Form 8992, U.S Shareholder Calculation of Global Intangible Low-Taxed Income (GILTI)
Form 8994, Employer Credit for Paid Family and Medical Leave
Form 8996, Qualified Opportunity Fund

New Schedules for Existing Forms

Form 5471 Sch. E Income, War Profits, and Excess Profits Taxes Paid or Accrued
Form 5471 Sch. H Current Earnings and Profits
Form 5471 Sch. I-1 Information for Global Intangible Low-Taxed Income.
Form 5471 Sch. P Transfer of Property to a Foreign Corporation
Form 8865 Sch. G Statement of Application for the Gain Deferral Method Under Section 721(c)
Form 8865 Sch. H Acceleration Events and Exceptions Reporting Relating to Gain Deferral
Method Under Section 721(c)
Form 965 Sch. A U.S. Shareholder's Section 965(a) Inclusion Amount
Form 965 Sch. B Deferred Foreign Income Corporation's Earnings and Profits
Form 965 Sch. C U.S. Shareholder's Aggregate Foreign Earnings and Profits Deficit
Form 965 Sch. D U.S. Shareholder's Aggregate Foreign Cash Position
Form 965 Sch. E U.S. Shareholder's Aggregate Foreign Cash Position Detail
Form 965 Sch. F Foreign Taxes Deemed Paid by Domestic Corporation for U.S. Shareholder Tax
Form 965 Sch. G Foreign Taxes Deemed Paid by Domestic Corporation (for U.S. Shareholder Tax
Year Ending in 2017)
Form 965 Sch. H Disallowance of Foreign Tax Credit and Amounts Reported on Forms 1116 and
1118
Form 965-A, Individual Report of Net 965 Tax Liability
Form 965-B, Corporate and Real Estate Investment Trust (REIT) Report of Net 965 Tax Liability
and Electing REIT Report of 965 Amounts
Form 965 Inclusion of Deferred Foreign Income Upon Transition to Participate Exemption
System

Obsolete Forms

Form 1065-B – U.S. Individual Income Tax Return

Form 8893, Election of Partnership Level Tax Treatment

Enhancements

Composite Returns

Federal > Common State/City > State Composite Generation is added as an option to activate
state composite returns without going to the state level input.

Pass-Through Input

Added more ratio ID inputs to passthrough input.

Qualified conservation property
Conservation reserve program payments
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New investment income
Credits that did not support ratio IDs previously

States

Tax Changes to Existing Forms

Arkansas

Form AR1000CR Composite Return
Corporate partners are allowed at a tax rate of 6.5%.

Schedule B added for corporate partners.

AR Schedule K-1
A second column has been added for AR amounts (after apportionment).

Form AR1050
New Page 2 added to calculate AR depreciation and apportionable income.

New Page 3 added to calculate apportioned income and total taxable income.

New Schedule K added as Page 4.

Page 2 in 2017 is now Page 5 in 2018.

Connecticut

Connecticut Pass-Through Entity Tax Return has replaced the Connecticut Composite Income Tax Return.

Illinois

Vouchers IL-505-B, IL-561-I, and IL-561-B are being replaced with IL-1065-V.

Louisiana

Form 565, Partnership Return of Income redesigned, 4 pages expanded to 12 pages.

North Carolina

Apportionment changed from 3 factors to single sales factor.

New Forms

Delaware

Form 8821DE Authorization to Release Tax Information
Federal > Other > 8821 – Tax Info Authorization

Indiana

Schedule EZ 1, 2, 3, To Determine Enterprise Zone Adjusted Gross Income for Employment
Expense Tax Credit

Indiana > Sch EZ 123 Enterprise Zone Employment Tax Credit

Kentucky

Schedule INV, Kentucky Inventory Tax Credit
Kentucky Partnership (765/765GP) > Credits > Sch INV
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Minnesota

Schedule KPCNC, Federal Adjustments
Minnesota > Income/Deductions > Federal Adjustments not Adopted

Schedule KPINC, Federal Adjustments
Minnesota > Income/Deductions > Federal Adjustments not Adopted

Schedule KSNC, Federal Adjustments
Minnesota > Income/Deductions > Federal Adjustments not Adopted

Schedule M4NC, Federal Adjustments
Minnesota > Income/Deductions > Federal Adjustments not Adopted

Schedule LK, Like-Kind Exchanges
Federal > Income/Deductions > 8824 – Like Kind Exchanges

New Hampshire

Schedule IV - Other Internal Revenue Code Reconciling Adjustments
New Hampshire > Income/Deductions > NH SCH IV IRC Adjustments

New York

Form IT-643 - Hire a Veteran Credit
New York > Credits > IT-643 and IT-644

Form IT-644 - Workers with Disabilities Tax Credit
New York > Credits > IT-643 and IT-644

Form IT-649 - Farm Donation to Food Pantries Credit
New York > Credits > IT-649

Form IT-647 and IT-647 ATT - Farm Workforce Retention Credit
New York > Credits > IT-647

Ohio - Ohio Cities

Form MNP 10, Municipal Net Profits Tax Return
Ohio > Ohio Cities > Tax Agency

Form MNP ES, Municipal Net Profit Declaration of Estimated Taxes
Federal > Payments/Penalties/Estimates > Estimates and Application of Overpayment

NOL Worksheets
Ohio > Ohio Cities > City Detail > Net Operating Loss

Virginia

Schedule 500AP - Modified Apportionment Schedule for VEDP-Certified Companies
Virginia > Allocations and Apportionment > Apportionment

Wisconsin

Schedule AR - Explanation of Amended Return
Federal > Basic Data

Wisconsin > General
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Schedule ES - Employee College Savings Account Contribution Credit
Wisconsin > Credits > Employee College Savings Account Contribution Credit (Schedule ES)

Schedule LI – Wisconsin Low-Income Housing Tax Credit
Wisconsin > Credits > Low-Income Housing Tax Credit (Schedule LI)

Enhancements

Louisiana

Added Electronic filing for the Form 565 Partnership return.

Missouri – Kansas City

Added Electronic filing for Form RD-108.

Ohio

Added Electronic filing for Form IT-1140 and IT-4708.

Ohio - Ohio Cities

Electronic filing available for RITA.
Electronic filing available for MNP, Municipal Net Profits Tax Return.
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Corporation (1120) Product Enhancements
Return to Table of Contents.

Federal

Tax Reform Changes to Existing Forms

Form 1120

Form 1120 has increased to 6 pages.
Form 1120, Schedule C has increased in size due to Dividends and Inclusions and new Schedule
K questions.
DPAD line changed to “Reserved for Future Use.”
Form 1120, 965 tax broken out separately on Line 32.
5 new dividend codes added:

OFD – Line 13
In 2017 - OFD was shown on Line 11 as dividends from affiliated group members

S965 – Line 15

SCFC – Line 16a

HYB– Line 16b

GILTI – Line 17

Form 1120, Schedule C, Line 22 – Sec 250 deduction carries from new Form 8993.
Form 1120, Schedule C, Line 16 – 965 additional income will now be shown as a dividend in
2018.

In 2017, 965 income was not shown on the 1120.

965(c) deduction will be shown on Line 15(c).

Form 1120, Page 5, Questions 20 through 25 are new

Schedule O

Consent Plan and Apportionment schedule for a Controlled Group has gone from 4 pages to 2.

Form 1120-C

Changes related to Section 965.

Form 965

Form is e-fileable.
Payments will be integrated with return payments.

Form 8082, Notice of Inconsistent Treatment or Administrative Adjustment Request(AAR)

Additional questions in Part 1.
Line 2 options have changed.

Note: All federal changes are being made with deconforming states in mind, designating existing
federal input as “State Only” for continued use.
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Section 199A

A new set of worksheets will be available for the Qualified Business Income Deduction.

No worksheets have been released by the IRS, so we are proceeding with implementing a version designed
internally. This includes new worksheets to compute this QBI deduction for applicable schedules, new fields
to include/exclude business entities from QB status, new fields per asset to include/exclude assets from
UBIA, and new fields for ADS assets to alter the life.

Federal > Income/Deductions > Section 199A – Qualified Business Income

New Forms

Form 8838-P, Consent to Extend Time to Assess Tax Per Gain Deferral Method
Form 8990, Limitation on Business Interest Expense IRC 163(j)
Form 8991, Tax on Base Erosion Payments of Taxpayers with Substantial Gross Receipts
Form 8992, U.S Shareholder Calculation of Global Intangible Low-Taxed Income (GILTI)
Form 8993, Section 250 Deduction for Foreign-Derived Intangible Income (FDII) and Global
Intangible Low-Taxed Income (GILTI)
Form 8994, Employer Credit for Paid Family and Medical Leave
Form 8996, Qualified Opportunity Fund

New Schedules for Existing Forms

Form 5471 Sch. E Income, War Profits, and Excess Profits Taxes Paid or Accrued
Form 5471 Sch. H Current Earnings and Profits
Form 5471 Sch. I-1 Information for Global Intangible Low-Taxed Income.
Form 5471 Sch. P Transfer of Property to a Foreign Corporation
Form 8865 Sch. G Statement of Application for the Gain Deferral Method Under Section 721(c)
Form 8865 Sch. H Acceleration Events and Exceptions Reporting Relating to Gain Deferral
Method Under Section 721(c)
Form 965 Sch. A U.S. Shareholder's Section 965(a) Inclusion Amount
Form 965 Sch. B Deferred Foreign Income Corporation's Earnings and Profits
Form 965 Sch. C U.S. Shareholder's Aggregate Foreign Earnings and Profits Deficit
Form 965 Sch. D U.S. Shareholder's Aggregate Foreign Cash Position
Form 965 Sch. E U.S. Shareholder's Aggregate Foreign Cash Position Detail
Form 965 Sch. F Foreign Taxes Deemed Paid by Domestic Corporation for U.S. Shareholder Tax
Form 965 Sch. G Foreign Taxes Deemed Paid by Domestic Corporation (for U.S. Shareholder Tax
Year Ending in 2017)
Form 965 Sch. H Disallowance of Foreign Tax Credit and Amounts Reported on Forms 1116 and
1118
Form 965-A, Individual Report of Net 965 Tax Liability
Form 965-B, Corporate and Real Estate Investment Trust (REIT) Report of Net 965 Tax Liability
and Electing REIT Report of 965 Amounts
Form 965 Inclusion of Deferred Foreign Income Upon Transition to Participate Exemption
System
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Obsolete Forms

Form 4626, Alternative Minimum Tax - Corporations
Form 1118 AMT – Foreign Tax Credit
Form 8810 AMT and ACE version
Schedule D and Form 8949 AMT version
Form 6252 AMT version – Installment Sales
Form 4797 AMT version
Form 1139 – Corporation Application for Tentative Refund is no longer highlighted when a
current year NOL is present.

Reason is due to carrybacks is now being severely limited. To produce the form, entries
on the Other > Form 1139 worksheet are now required.

Form 8926 – Disqualified Corporate Interest Expense Disallowed Under Section 163(j)
Replaced with new interest expense limitation Form 8990

Enhancements

1120 PH New Pro Forma Information. Dividend Carryovers from the previous two tax years will
now be pro formaed.
New drilldown screen added for Schedule PH (Form 1120), Page 1, Line 8b.
Detail for the 1.170A-11(c)(2) charitable contribution carryover conversion to NOL carryover
added to the NOL drilldown screen for Form 1120, Page 1, Line 29a.
Contribution Detail not Carried to Form 8283 - New Code added for “Type” for 15% Charitable
Contribution Limitation.
Pass-Through Input - Added more ratio ID inputs to passthrough input:

Qualified conservation property

Conservation reserve program payments

New investment income

Remaining credits that did not support ratio IDs previously

States

Tax Changes to Existing Forms

Georgia

2D barcode added to Form 700.

Illinois

Vouchers IL-505-B and IL-1120-ES are being replaced with IL-1120-V.

Indiana

Schedule PC, H, and CC-20 split into separate forms:

IT-20 PIC
Disclosure of Intangible Expense and Directly Related Interest Expense

Tax Product Enhancements • 28



IT-20 FSD
Foreign Source Dividend Deduction Schedule

CC-40
College and University Contribution Credit

North Carolina

Apportionment changed from 3 factors to single sales factor.

New Forms

Delaware

Form 8821DE Authorization to Release Tax Information
Federal > Other > 8821 – Tax Info Authorization

Kentucky

Schedule INV, Kentucky Inventory Tax Credit
Kentucky Partnership (765/765GP) > Credits > Sch INV

Minnesota

Schedule KPCNC, Federal Adjustments
Minnesota > Income/Deductions > Federal Adjustments not Adopted

Schedule KPINC, Federal Adjustments
Minnesota > Income/Deductions > Federal Adjustments not Adopted

Schedule KSNC, Federal Adjustments
Minnesota > Income/Deductions > Federal Adjustments not Adopted

Schedule M4NC, Federal Adjustments
Minnesota > Income/Deductions > Federal Adjustments not Adopted

Schedule LK, Like-Kind Exchanges
Federal > Income/Deductions > 8824 – Like Kind Exchanges

New Hampshire

Schedule IV - Other Internal Revenue Code Reconciling Adjustments
New Hampshire > Income/Deductions > NH SCH IV IRC Adjustments

Ohio - Ohio Cities

Form MNP 10, Municipal Net Profits Tax Return
Ohio > Ohio Cities > Tax Agency

Form MNP ES, Municipal Net Profit Declaration of Estimated Taxes
Federal > Payments/Penalties/Estimates > Estimates and Application of Overpayment

NOL Worksheets
Federal > Income/Deductions > NOL Carryover / Carryback
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Virginia

Schedule 500AP - Modified Apportionment Schedule for VEDP-Certified Companies
Virginia > Allocations and Apportionment > Apportionment

Wisconsin

Schedule AR - Explanation of Amended Return
Federal > Basic Data

Wisconsin > General

Schedule ES - Employee College Savings Account Contribution Credit
Wisconsin > Credits > Employee College Savings Account Contribution Credit (Schedule ES)

Schedule LI – Wisconsin Low-Income Housing Tax Credit
Wisconsin > Credits > Low-Income Housing Tax Credit (Schedule LI)

Enhancements

Illinois

Added electronic filing for Schedule INS, Tax for Foreign Insurers.

Kentucky

Added electronic filing for consolidated returns.

Missouri – Kansas City

Added electronic filing for Form RD-108.

New York

Added electronic filing for Form CT-33, Life Insurance Corporation Franchise Tax Return.
Added electronic filing for Form CT-33NL, Non-Life Insurance Corporation Franchise Tax
Return.
Added electronic filing for Form CT-33C, Captive Insurance Company Franchise Tax Return.

Ohio - Ohio Cities

Added electronic filing for RITA.
Added electronic filing for MNP, Municipal Net Profits Tax Return.
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S Corporation (1120S) Product Enhancements
Return to Table of Contents.

Federal

Tax Reform Changes to Existing Forms

Form 1120S

Form 1120S, Page 1, Form 8827 – Minimum Tax Credit, is now applicable to S Corporations.
Form 1120S, Page 2, Schedule B, Lines 9 and 10 are new.
Form 1120S, Page 3, Schedule B, Line 15 is new.
Form 1120S, Page 3, Schedule K, Lines 14d, 14e, 14k, and 14l are changed for Section 965.
Form 1120S, Page 5, Schedule M-2, Accumulated Earnings and Profits column added to Schedule
M-2.

Schedule K-1

Removed DPAD codes P through R.
Removed codes M through U.
Added codes V-Z for Section 199A.

Form 965

Form is e-fileable.
Payments will be integrated with return payments.

Form 8082, Notice of Inconsistent Treatment or Administrative Adjustment Request (AAR)

Added questions in Part 1.
Changed Line 2 options.

Note: All federal changes are being made with deconforming states in mind, designating existing
federal input as “State Only” for continued use.

Section 199A

A new set of worksheets will be available for the Qualified Business Income Deduction.

No worksheets have been released by the IRS, so we are proceeding with implementing a version designed
internally. This includes new worksheets to compute this QBI deduction for applicable schedules, new fields
to include/exclude business entities from QB status, new fields per asset to include/exclude assets from
UBIA, and new fields for ADS assets to alter the life.

Federal > Income/Deductions > Section 199A – Qualified Business Income

New Forms

Form 8838-P, Consent to Extend Time to Assess Tax Per Gain Deferral Method
Form 8990, Limitation on Business Interest Expense IRC 163(j)
Form 8992, U.S. Shareholder Calculation of Global Intangible Low-Taxed Income (GILTI)
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Form 8994, Employer Credit for Paid Family and Medical Leave
Form 8996, Qualified Opportunity Fund

New Schedules for Existing Forms

Form 5471 Sch. E Income, War Profits, and Excess Profits Taxes Paid or Accrued
Form 5471 Sch. H Current Earnings and Profits
Form 5471 Sch. I-1 Information for Global Intangible Low-Taxed Income.
Form 5471 Sch. P Transfer of Property to a Foreign Corporation
Form 8865 Sch. G Statement of Application for the Gain Deferral Method Under Section 721(c)
Form 8865 Sch. H Acceleration Events and Exceptions Reporting Relating to Gain Deferral
Method Under Section 721(c)
Form 965 Sch. A U.S. Shareholder's Section 965(a) Inclusion Amount
Form 965 Sch. B Deferred Foreign Income Corporation's Earnings and Profits
Form 965 Sch. C U.S. Shareholder's Aggregate Foreign Earnings and Profits Deficit
Form 965 Sch. D U.S. Shareholder's Aggregate Foreign Cash Position
Form 965 Sch. E U.S. Shareholder's Aggregate Foreign Cash Position Detail
Form 965 Sch. F Foreign Taxes Deemed Paid by Domestic Corporation for U.S. Shareholder Tax
Form 965 Sch. G Foreign Taxes Deemed Paid by Domestic Corporation (for U.S. Shareholder Tax
Year Ending in 2017)
Form 965 Sch. H Disallowance of Foreign Tax Credit and Amounts Reported on Forms 1116 and
1118
Form 965-A, Individual Report of Net 965 Tax Liability
Form 965-B, Corporate and Real Estate Investment Trust (REIT) Report of Net 965 Tax Liability
and Electing REIT Report of 965 Amounts
Form 965 Inclusion of Deferred Foreign Income Upon Transition to Participate Exemption
System

Enhancements

Composite Returns
Federal > Common State/City > State Composite Generation is added as an option to
activate state composite returns without going to the state level input.

Pass-Through Input - Added more ratio ID inputs to passthrough input.
Qualified conservation property

Conservation reserve program payments

New investment income

Remaining credits that did not support ratio IDs previously
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States

Tax Changes to Existing Forms

Arkansas

Form AR1000CR Composite Return
Corporate partners are allowed at a tax rate of 6.5%.

Added Schedule B for corporate partners.

AR Schedule K-1
Added a second column for AR amounts (after apportionment).

Connecticut

Connecticut Pass-Through Entity Tax Return has replaced the Connecticut Composite Income Tax Return.

Illinois

Vouchers IL-505-B, IL-561-I, and IL-561-B are being replaced with IL-1120-ST-V.

North Carolina

Apportionment changed from three factors to single sales factor.

New Forms

Delaware

Form 8821DE Authorization to Release Tax Information

Federal > Other > 8821 – Tax Info Authorization

Kentucky

Schedule INV, Kentucky Inventory Tax Credit

Kentucky Partnership (765/765GP) > Credits > Sch INV

Minnesota

Schedule KPCNC, Federal Adjustments
Minnesota > Income/Deductions > Federal Adjustments not Adopted

Schedule KPINC, Federal Adjustments
Minnesota > Income/Deductions > Federal Adjustments not Adopted

Schedule KSNC, Federal Adjustments
Minnesota > Income/Deductions > Federal Adjustments not Adopted

Schedule M4NC, Federal Adjustments
Minnesota > Income/Deductions > Federal Adjustments not Adopted

Schedule LK, Like-Kind Exchanges
Federal > Income/Deductions > 8824 – Like Kind Exchanges

New Hampshire

Schedule IV - Other Internal Revenue Code Reconciling Adjustments

New Hampshire > Income/Deductions > NH SCH IV IRC Adjustments
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New York City

Form NYC-1A, Combined Tax Return for Banking Corporations

New York > New York City Banking (NYC-1, NYC-1A)

Ohio Cities

Form MNP 10, Municipal Net Profits Tax Return
Ohio > Ohio Cities > Tax Agency

Form MNP ES, Municipal Net Profit Declaration of Estimated Taxes
Federal > Payments/Penalties/Estimates > Estimates and Application of Overpayment

NOL Worksheets
Federal > Income/Deductions > NOL Carryover / Carryback

Virginia

Schedule 500AP - Modified Apportionment Schedule for VEDP-Certified Companies

Virginia > Allocations and Apportionment > Apportionment

Wisconsin

Schedule AR - Explanation of Amended Return
Federal > Basic Data

Wisconsin > General

Schedule ES - Employee College Savings Account Contribution Credit
Wisconsin > Credits > Employee College Savings Account Contribution Credit (Schedule ES)

Schedule LI – Wisconsin Low-Income Housing Tax Credit
Wisconsin > Credits > Low-Income Housing Tax Credit (Schedule LI)

Enhancements

Missouri – Kansas City

Added electronic filing for Form RD-108.

New York City

Electronic filing is now available for Combined returns.

Ohio

Added electronic filing for Forms IT-1140 and IT-4708.

Ohio Cities

Electronic filing is now available for RITA.
Electronic filing is now available for MNP, M.
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Fiduciary (1041) Product Enhancements
Return to Table of Contents.Federal

Federal

Tax Reform Changes to Existing Forms

Form 1041

Removed 2% deductions.
Limited state and local taxes (Line 11).

Corresponding changes have been made to Form 1040NR.

Form ESBT

Charitable contributions are now limited using individual provisions for ESBTs.
Limited state and local taxes (Taxes Line).

Schedule D

Updated capital gains thresholds on the Schedule D, Page 2, Lines 28 and 33 and the Schedule D
worksheet, Lines 15 and 23.
Where appropriate, corresponding changes were made to Form 1116 and the Tentative Credit
for Prior Year Minimum Tax.

Form 8824

Limited to real property.

Form 4684

Limited casualty losses to presidentially declared disasters.

Form 1116

Added new income baskets, Section 951A & Foreign branch.
Recharacterized overall domestic losses. The taxpayer may elect to recharacterize an amount
greater than 50%, up to 100%.

NOL

Current year
Removed adjustment for DPAD deduction.

Carryover worksheet
Removed adjustment for miscellaneous itemized deductions subject to 2% of AGI limit.

Removed adjustment for DPAD deduction.

Form 965

Form is e-fileable.
Payments will be integrated with return payments.
Not distributed 965 income does not flow to the Federal 1041 (only the tax flows to Schedule
G, Line 7). The IRC 965 Transition Tax Statement produces based on this information.
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Distributed 965 income flows to Federal 1041, Line 7, and then is backed out on Schedule B,
Line 15. This amount flows to the K-1 and is input only.
Conforming states must add in the not distributed 965 income in order to tax it (as it is not
included in federal taxable income).
Non-conforming states do nothing.
965 treatment is being revised to be included in income. All states will change in concert.

Note: All federal changes are being made with deconforming states in mind, designating existing
federal input as “State Only” for continued use

Section 199A

A new set of worksheets will be available for the Qualified Business Income Deduction.

No worksheets have been released by the IRS, so we are proceeding with implementing a version designed
internally. This includes new worksheets to compute this QBI deduction for applicable schedules, new fields
to include/exclude business entities from QB status, new fields per asset to include/exclude assets from
UBIA, and new fields for ADS assets to alter the life.

Income > Sch C – Business > Qualified Business Income
Income > Sch E, p 1 – Rent and Royalty > Qualified Business Income
Income > Sch E, p 2 – Fiduciary Passthrough (K-1 1041) > Qualified Business Income
Income > Sch E, p 2 – Partnership Passthrough (K-1 1065) > Qualified Business Income
Income > Sch E, p 2 – Large Partnership Passthrough (K-1 1065-B) > Qualified Business Income
Income > Sch E, p 2 – S Corporation Passthrough (K-1 1120S) > Qualified Business Income
Deductions > Qualified Business Income
Income > Sch F / 4835 – Farm > Qualified Business Income

New Forms

Form 8838-P, Consent to Extend Time to Assess Tax Per Gain Deferral Method
Form 8990, Limitation on Business Interest Expense IRC 163(j)
Form 8992, U.S Shareholder Calculation of Global Intangible Low-Taxed Income (GILTI).

Taxes > 8992 – U.S. Shareholder Calculation of Global Intangible Low-Taxed Income
(GILTI)

Form 8994, Employer Credit for Paid Family and Medical Leave
Income > Sch C – Business > Form 8994 – Employer Credit for Paid Family and Medical
Leave
Income > Sch E, p 2 – Fiduciary Passthrough (K-1 1041) > Form 8994 – Employer Credit for
Paid Family and Medical Leave
Income > Sch E, p 2 – Partnership Passthrough (K-1 1065) > Form 8994 – Employer Credit
for Paid Family and Medical Leave
Income > Sch E, p 2 – Large Partnership Passthrough (K-1 1065-B) > Form 8994 – Employer
Credit for Paid Family and Medical Leave
Income > Sch E, p 2 – S Corporation Passthrough (K-1 1120S) > Form 8994 – Employer
Credit for Paid Family and Medical Leave
Income > Sch F / 4835 – Farm > Form 8994 – Employer Credit for Paid Family and Medical
Leave
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Form 461, Limitation on Business Losses
Income > 461 – Limitation on Business Losses

New Schedules for Existing Forms

Form 8865 Sch. G, Statement of Application for the Gain Deferral Method Under Section 721(c)
Form 8865 Sch. H, Transactions Between controlled Foreign Partnership and Partners or Other
Related persons
Form 965 Sch. A, U.S. Shareholder's Section 965(a) Inclusion Amount
Form 965 Sch. B, Deferred Foreign Income Corporation's Earnings and Profits
Form 965 Sch. C, U.S. Shareholder's Aggregate Foreign Earnings and Profits Deficit
Form 965 Sch. D, U.S. Shareholder's Aggregate Foreign Cash Position
Form 965 Sch. E, U.S. Shareholder's Aggregate Foreign Cash Position Detail
Form 965 Sch. F, Foreign Taxes Deemed Paid by Domestic Corporation for U.S. Shareholder Tax
Form 965 Sch. G, Foreign Taxes Deemed Paid by Domestic Corporation (for U.S. Shareholder
Tax Year Ending in 2017)
Form 965 Sch. H, Disallowance of Foreign Tax Credit and Amounts Reported on Forms 1116 and
1118
Form 965-A, Individual Report of Net 965 Tax Liability
Form 965, Inclusion of Deferred Foreign Income Upon Transition to Participate Exemption
System

Enhancements

Interest and Dividend Summary

Added new columns for:

Market discount
Section 199A dividends
Unrecaptured Section 1250 gain
Section 1202 gain
Collectibles
Investment expense

Form 1116

Added input for AMT if different foreign tax amounts.
Credits – Foreign Tax Credit > General > Part II - AMT Code

Added a statement showing the breakdown of foreign income distributed versus not distributed.
Prints with the Income Summary 2 form.
Added ability to select income resourced by treaty on 1099-DIV.

Income – Dividends > Foreign Information > Income type
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States

New Forms

Arkansas

AR K-FE – Owner’s Share of Income, Deductions, Credits
Form 1099-PT, Report of Tax Withheld or Paid on Behalf

Arkansas > Other > AR-1099PT Beneficiary Information

Form 4684, Casualties and Thefts

Delaware

Form 8821, Authorization to Release Tax Info

This uses existing input on Federal > Form 2848 Power of Attorney & Form 8821 Tax Info
Authorization.

Illinois

K-1-P (including e-file)
Illinois > Schedule K-1-P

K-1-T (including e-file)
Illinois > Schedule K-1-T

Kentucky

Schedule INV, Inventory Tax Credit

Kentucky > Payments/Credits > Inventory Tax Credit

Michigan

Form 1041-V, e-file Payment Voucher
Form 5595, Excess Business Loss
Form 5606, Excess Business Loss Continuation
Form 8453-FE, Estate or Trust Declaration for e-file

Minnesota

Schedule LK, Like Kind Exchange
Schedule M2NC

Federal Adjustments MN > Adjustments

Schedule M2SBNC
Federal Adjustments MN > Adjustments

Schedule KFNC
Federal Adjustments MN > Adjustments

New Hampshire

Schedule IV, Other IRC Reconciling Adjustments
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New Hampshire > Income / Deductions > Increases / Decreases to Gross Business Profits to
Reconcile to IRC – NH-1041

New Mexico

Form RPD-41375, NOL Carryforward

New Mexico > General > Net Operating Loss

New York

Form IT-649, Farm Donations to Food Pantries Credit

New York > Credits > Farm Donations to Food Pantries Credit

North Dakota

Form 38-PV, Fiduciary Paper Return Payment Voucher
Schedule TC, Tax Credits

North Dakota > Credits

Wisconsin

Schedule ES – Employee College Savings Account Credit
Wisconsin > Credits > Schedule CR Credits

Schedule LI – Low-Income Housing Tax Credit
Wisconsin > Credits > Schedule CR Credits

Enhancements

Kentucky

Added electronic filing (tax year 2017).

Michigan

Added electronic filing.

Ohio

Removed the Annualization section of OH IT 2210 and OH SD 2210, Underpayments of
Estimated Tax.
Added Form 1140 for electronic filing.
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Estate and Gift (706/709) Product Enhancements
Return to Table of Contents.

There are no updates available with this release.
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Exempt Organization (990) Product Enhancements
Return to Table of Contents.

Federal

Tax Reform Changes to Existing Forms

Form 990

Page 5, Part V, Line 15 – new question regarding tax on remuneration of more than $1,000,000
or excess parachute payments.
Page 5, Part V, Line 16 – new question regarding educational institution subject to tax on net
investment income.

Form 990-PF

Page 6, Part VII-B, Line 8 – new question regarding tax on remuneration of more than $1,000,000 or excess
parachute payments.

Form 990-T

Page 1, Parts I & II – organizations that have more than one unrelated trade or business must
compute UBTI separately for each trade or business using new Schedule M.
Page 2, Part III – new Line 34 for amounts paid for disallowed fringes.
Page 2, Part V – new Line 49 for 965 tax liability.

Schedule B, Schedule of Contributors

Certain types of organizations will no longer be required to report names and addresses of contributors when
prepared as attachment for Form 990 or 990-EZ.

Form 4720

Page 9, Schedule N is used to compute tax on excess compensation (Section 4960).
Page 9, Schedule M is used to compute tax on net investment income of private colleges and
universities (Section 4968).

Form 965

Form is e-fileable.
Payments will be integrated with return payments.

Section 199A

A new set of worksheets will be available for the Qualified Business Income Deduction.

No worksheets have been released by the IRS, so we are proceeding with implementing a version designed
internally. This includes new worksheets to compute this QBI deduction for applicable schedules, new fields
to include/exclude business entities from QB status, new fields per asset to include/exclude assets from
UBIA, and new fields for ADS assets to alter the life.

Federal > Income/Deductions > Section 199A – Qualified Business Income
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New Forms

Form 8990, Limitation on Business Interest Expense IRC 163(j)
Form 8992, U.S Shareholder Calculation of Global Intangible Low-Taxed Income (GILTI)

New Schedules for Existing Forms

Form 5471 Sch. E Income, War Profits, and Excess Profits Taxes Paid or Accrued
Form 5471 Sch. H Current Earnings and Profits
Form 5471 Sch. I-1 Information for Global Intangible Low-Taxed Income.
Form 5471 Sch. P Transfer of Property to a Foreign Corporation
Form 8865 Sch. G Statement of Application for the Gain Deferral Method Under Section 721(c)
Form 8865 Sch. H Acceleration Events and Exceptions Reporting Relating to Gain Deferral
Method Under Section 721(c)
Form 965 Sch. A U.S. Shareholder's Section 965(a) Inclusion Amount
Form 965 Sch. B Deferred Foreign Income Corporation's Earnings and Profits
Form 965 Sch. C U.S. Shareholder's Aggregate Foreign Earnings and Profits Deficit
Form 965 Sch. D U.S. Shareholder's Aggregate Foreign Cash Position
Form 965 Sch. E U.S. Shareholder's Aggregate Foreign Cash Position Detail
Form 965 Sch. F Foreign Taxes Deemed Paid by Domestic Corporation for U.S. Shareholder Tax
Form 965 Sch. G Foreign Taxes Deemed Paid by Domestic Corporation (for U.S. Shareholder Tax
Year Ending in 2017)
Form 965 Sch. H Disallowance of Foreign Tax Credit and Amounts Reported on Forms 1116 and
1118
Form 965-A, Individual Report of Net 965 Tax Liability
Form 965-B, Corporate and Real Estate Investment Trust (REIT) Report of Net 965 Tax Liability
and Electing REIT Report of 965 Amounts
Form 965 Inclusion of Deferred Foreign Income Upon Transition to Participate Exemption
System

Enhancements

Pass-Through Input - Expanded inputs for passthrough income for Form 990-T.

States

Tax Changes to Existing Forms

Illinois

Vouchers IL-505-B and IL-1120-ES are being replaced with IL-990-T-V.
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Employee Benefit Plan (5500) Product Enhancements
Return to Table of Contents.

There are no updates available with this release.
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